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Preface

About This Guide

This Getting Started Guide introduces you to System Generator for DSP, then provides 
installation and configuration instructions, release information, and six mini-training 
modules that highlight the main features of the product. Each module starts with a lesson 
of 8-10 slides that explain important concepts, followed by a lab exercise that take about 30 
minutes to complete. Because this introductory training is part of the tool, you can 
progress through the material at your own pace and on your own time schedule

Guide Contents
This Getting Started Guide contains the following topics:

• Introduction

• Installation

• Release Information

• Getting Started

a. Design Creation Basics

b. Fixed Point and Bit Operations

c. System Control

d. Multi-Rate Systems

e. Using Memories

f. Designing Filters

g. Additional Examples and Tutorials

System Generator PDF Doc Set
This Getting Started Guide can be found in the System Generator Help system and is also 
part of the System Generator Doc Set that is provided in PDF format. The content of the 
doc set is as follows:

• System Generator for DSP Getting Started Guide

• System Generator for DSP User Guide

• System Generator for DSP Reference Guide

Note: Hyperlinks across these PDF documents work only when the PDF files reside in the same 
folder. After clicking a Hyperlink in the Adobe Reader, you can return to the previous page by pressing 
the Alt key and the left arrow key (←) at the same time.
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Additional Resources
To find additional documentation, see the Xilinx website at:

http://www.xilinx.com/literature. 

To search the Answer Database of silicon, software, and IP questions and answers, or to 
create a technical support WebCase, see the Xilinx website at:

http://www.xilinx.com/support.

Conventions
This document uses the following conventions. An example illustrates each convention.

Typographical
The following typographical conventions are used in this document:

Convention Meaning or Use Example

Courier font Messages, prompts, and 
program files that the system 
displays

speed grade: - 100

Courier bold Literal commands that you 
enter in a syntactical statement

ngdbuild design_name

Helvetica bold Commands that you select from 
a menu

File → Open

Keyboard shortcuts Ctrl+C

Italic font Variables in a syntax statement 
for which you must supply 
values

ngdbuild design_name

References to other manuals See the Development System 
Reference Guide for more 
information.

Emphasis in text If a wire is drawn so that it 
overlaps the pin of a symbol, 
the two nets are not connected.

Square brackets    [  ] An optional entry or parameter. 
However, in bus specifications, 
such as bus[7:0], they are 
required.

ngdbuild [option_name] 
design_name

Braces    {  } A list of items from which you 
must choose one or more

lowpwr ={on|off}

Vertical bar    | Separates items in a list of 
choices

lowpwr ={on|off}
8 www.xilinx.com System Generator for DSP
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Online Document
The following conventions are used in this document:

Vertical ellipsis
.
.
.

Repetitive material that has 
been omitted

IOB #1: Name = QOUT’ 
IOB #2: Name = CLKIN’
.
.
.

Horizontal ellipsis  . . . Repetitive material that has 
been omitted

allow block  block_name loc1 
loc2 ... locn;

Convention Meaning or Use Example

Convention Meaning or Use Example

Blue text Cross-reference link to a 
location in the current 
document

See the topic “Additional 
Resources” for details.

Refer to “Title Formats” in 
Chapter 1 for details.

Red text Cross-reference link to a 
location in another document 

See Figure 2-5 in the Virtex-II 
Platform FPGA User Guide.

Blue, underlined text Hyperlink to a website (URL) Go to http://www.xilinx.com 
for the latest speed files.
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Chapter 1

Introduction

System Generator is a DSP design tool from Xilinx that enables the use of The Mathworks 
model-based design environment Simulink for FPGA design. Previous experience with 
Xilinx FPGAs or RTL design methodologies are not required when using System 
Generator. Designs are captured in the DSP friendly Simulink modeling environment 
using a Xilinx specific blockset. All of the downstream FPGA implementation steps 
including synthesis and place and route are automatically performed to generate an FPGA 
programming file.
System Generator for DSP www.xilinx.com 11
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The Xilinx DSP Block Set
Over 90 DSP building blocks are provided in the Xilinx DSP blockset for Simulink. These 
blocks include the common DSP building blocks such as adders, multipliers and registers. 
Also included are a set of complex DSP building blocks such as forward error correction 
blocks, FFTs, filters and memories. These blocks leverage the Xilinx IP core generators to 
deliver optimized results for the selected device.
12 www.xilinx.com System Generator for DSP
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FIR Filter Generation
System Generator includes a FIR Compiler block that targets the dedicated DSP48 
hardware resources in the Virtex4 and Virtex5 devices to create highly optimized 
implementations that can run in excess of 500 Mhz. Configuration options allow 
generation of direct, polyphase decimation, polyphase interpolation and oversampled 
implementations. Standard MATLAB functions such as fir2 or The Mathworks FDAtool 
can be used to create coefficients for the Xilinx FIR Compiler.
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Support for MATLAB
Algorithmic MATLAB models can be incorporated into System Generator through 
AccelDSP. AccelDSP includes powerful algorithmic synthesis that takes floating-point 
MATLAB as input and generates a fully scheduled fixed-point model for use with System 
Generator. Features include floating- to fixed-point conversion, Automatic IP insertion, 
design exploration and algorithmic scheduling. Also included in System Generator is an 
MCode block that allows the use of non-algorithmic MATLAB for the modeling and 
implementation of simple control operations.
14 www.xilinx.com System Generator for DSP
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System Resource Estimation
System Generator provides a Resource Estimator block that quickly estimates the area of a 
design prior to place and route. This can be a valuable aid in the hardware / software 
partitioning process by helping system designers take full advantage of the FPGA 
resources which include up to 640 multiply/accumulate (or DSP) blocks in the Virtex5 
devices.
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Hardware Co-Simulation
System Generator provides accelerated simulation through hardware co-simulation. 
System Generator will automatically create a hardware simulation token for a design 
captured in the Xilinx DSP blockset that will run on one of over 20 supported hardware 
platforms. This hardware will co-simulate with the rest of the Simulink system to provide 
up to a 1000x simulation performance increase.
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System Integration Platform
System Generator provides a system integration platform for the design of DSP FPGAs 
that allows the RTL, Simulink, MATLAB and C/C++ components of a DSP system to come 
together in a single simulation and implementation environment.    System Generator 
supports a black box block that allows RTL to be imported into Simulink and co-simulated 
with either ModelSim or Xilinx ISE Simulator. System Generator also supports the 
inclusion of a MicroBlaze embedded processor running C/C++ programs.
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Chapter 2

Installation

Downloading
System Generator is only available via download from the Xilinx web page. You may 
purchase, register, and download the System Generator software from the site at:

http://www.xilinx.com/ise/optional_prod/system_generator.htm

Note: In special circumstances, System Generator can be delivered on a CD. Please contact your 
Xilinx distributor if your circumstances prohibit you from downloading the software via the web.

Hardware Co-Simulation Support
If you have an FPGA development board, you may be able to take advantage of System 
Generator’s ability to use FPGA hardware co-simulation with Simulink simulations. The 
System Generator software includes support for the XtremeDSP Development Kit, the 
MicroBlaze Multimedia Demonstration boards, the MVI hardware platform, the ML402 
Virtex-4 platform, the ML506 Virtex-5 platform, and the Spartan-3A DSP 1800 starter 
platform and 3400 development platform. Additional System Generator board support 
packages provide support for additional hardware co-simulation platforms. System 
Generator board support packages can be downloaded from the following URL:

http://www.xilinx.com/technology/dsp/thirdparty_devboards.htm

Installing

Software Prerequisites
You must have the following software installed before running System Generator.

• One of the following versions of MATLAB from The MathWorks Inc.:

• MATLAB v7.4/Simulink v6.6 (R2007a)

• MATLAB v7.5/Simulink v7.0 (R2007b)

Note: MATLAB must be installed in a directory with no spaces (e.g., C:\MATLAB\R2007a).

• Xilinx ISE Foundation version 10.1

Some features in System Generator require the following software to be installed:

• A logic synthesis tool. System Generator is fully compatible with Xilinx XST (included 
in the ISE Foundation bundle) and Synplify Pro v8.6.2 or v8.9 from Synplicity, Inc.

• A hardware description language (HDL) simulator is required only for co-simulating 
HDL modules within Simulink using System Generator. System Generator HDL co-
simulation interfaces are compatible with the Xilinx ISE Simulator, ModelSim Xilinx 
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Edition MXE (an option with ISE Foundation), and ModelSim PE or SE, version v6.3c, 
from Model Technology Inc.

Note: The Microsoft Windows environment variable $XILINX must be set and point to your ISE 
software installation directory.

ISE software service packs may be downloaded from the Xilinx Download Center:

http://www.xilinx.com/xlnx/xil_sw_updates_home.jsp

Using the ISE Design Suite Installer
Before invoking the ISE Design Suite Installer, it is a good idea to make sure that all 
instances of MATLAB are closed. When all instances of MATLAB are closed, launch the 
installer and follow the directions on the screen.

Choose MATLAB Version for System Generator

As the last step of the System Generator installation, click the check box of the MATLAB 
installation you wish to associate with this verison of System Generator, then click Apply. 

If you don’t see a valid version of MATLAB listed, for example a version installed on a 
network device, click the Add Version button, browse to the MATLAB root directory of the 
unlisted version, then click Add. If you wish to associate this version of MATLAB with 
System Generator, click the check box of the newly listed MATLAB installation, then click 
Apply. 

If you have no version of MATLAB available, click Choose Later to continue with the 
installation. At a later time, after you have installed MATLAB, you can associate that 
version of MATLAB with System Generator by executing the Windows menu item Start > 
All Programs > Xilinx ISE Design Suite 10.1 > DSP Tools > Select MATLAB version for 
Xilinx System Generator.

Hardware Co-Simulation Installation
This topic provides links to hardware and software installation procedures for hardware 
co-simulation. If you do not plan to use hardware co-simulation, you may skip this topic. 

Ethernet-Based Hardware Co-Simulation

 Installing an ML402 Board for Ethernet Hardware Co-Simulation

 Installing an ML506 Board for Ethernet Hardware Co-Simulation

Installing a Spartan-3A DSP 1800A Starter Platform for Ethernet Hardware Co-Simulation

 Installing a Spartan-3A DSP 3400A Development Platform for Ethernet Hardware Co-
Simulation

JTAG-Based Hardware Co-Simulation

 Installing an ML402 Board for JTAG Hardware Co-Simulation

Third-Party Hardware Co-Simulation

As part of the Xilinx XtremeDSP™ Initiative, Xilinx works with distributors and many 
OEMs to provide a variety of DSP prototyping and development platforms. Please refer to 
the following Xilinx web site page for more information on available platforms:
http://www.xilinx.com/technology/dsp/thirdparty_devboards.htm
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Compiling Xilinx HDL Libraries
If you intend to simulate System Generator designs using ModelSim, you must compile 
your IP (cores) libraries. This topic describes the procedure.

ModelSim (PE or EE/SE)

The Xilinx tool that compiles libraries for use in ModelSim PE or EE/SE is named 
compxlib. The following command can, for example, be used to compile all the VHDL and 
Verilog libraries with ModelSim SE:

compxlib –s mti_se –f all –l all

Complete instructions for running compxlib can be found in the ISE Software Manual 
titled “Synthesis and Simulation Design Guide”.

MXE Libraries

If you plan to use ModelSim XE (Xilinx Edition), download the MXE precompiled libraries 
from the Xilinx web site. Unzip these MXE libraries into the directory in which you have 
MXE installed, e.g.,   c:/Modeltech_XE/. This is the location where MXE expects to find 
your Xilinx compiled libraries, so it is not necessary to change your modelsim.ini file. This 
file should point to the correct installed location.

Configuring the System Generator Cache
Both the System Generator simulator and the design generator incorporate a disk cache to 
speed up the iterative design process. The cache does this by tagging and storing files 
related to simulation and generation, then recalling those files during subsequent 
simulation and generation rather than rerunning the time consuming tools used to create 
those files. 

Setting the Size

By default, the cache will use up to 500 MB of disk space to store files. To specify the 
amount of disk space the cache should use, set the SYSGEN_CACHE_SIZE environment 
variable to the size of the cache in megabytes. Set this number to a higher value when 
working on several large designs. 

Setting the Number of Entries

The cache entry database stores a fixed number of entries. The default is 20,000 entries. To 
set size of the cache entry database, set the SYSGEN_CACHE_ENTRIES environment 
variable to the desired number of entries. Setting this number too small will adversely 
affect cache performance. Set this number to a higher value when working on several large 
designs.

Displaying and Changing Versions of System Generator
It is possible to have several versions of System Generator installed. The MATLAB 
command xlVersion displays which versions are installed, and makes it possible to 
switch from one to another. xlVersion is useful when upgrading a model to run in the 
latest version of System Generator. 

Entering  "xlVersion" in the MATLAB console displays the versions of System Generator 
that are installed, and entering "xlVersion <version>" switches to the specified 
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version. For example, if the versions that are installed are 9.2.01 and 10.1, and the currently 
selected version is 10.1, then entering "xlVersion" displays 

Available System Generator installations: 
Version 9.2.01 in C:/Xilinx/9.2.01/DSP_Tools/sysgen 
Version 10.1 in C:/Xilinx/10.1/DSP_Tools/sysgen 

Current version of System Generator is 10.1. 

Entering "xlVersion 9.2.01" switches the System Generator version to 9.2.01. 

Occasionally, it is necessary to restart MATLAB to make it possible to switch. In this case, 
the response to entering "xlVersion 10.1" looks like the following: 

Please restart MATLAB and run xlVersion 10.1 again to switch. 

When the switch succeeds, xlVersion prints the following: 

Your System Generator has been switched. Please restart MATLAB. 

If you install System Generator 10.1 after you install 9.2.01, you need to install 10.1 again in 
order to make xlVersion work. 

Once you switch System Generator version, you need to switch to the right version of ISE 
in order to make System Generator work correctly.
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Chapter 3

Release Information

Release Notes 10.1

System Generator Enhancements

System Generator / Project Navigator Integration

System Generator designs can now be more easily incorporated into a larger design inside 
of Project Navigator by using a new source type in Project Navigator.  The System 
Generator design can also be launched from Project Navigator.

DCM Support

System Generator now provides the option to automatically include a DCM in a design.  
Although the optional DCM is abstracted away from the designer, the generated design 
will leverage DCMs available in the silicon. 

An alternative option exposes the clock ports at the top level for manual connection to a 
DCM. 

Dual Asynchronous-Clock Support for PLB46

This capability gives the designer additional flexibility by allowing the DSP and 
embedded processing portions of a design to run at different clock rates.

Run Time Speed Improvements

• Up to 2x faster first time initialization of a simulation

• >10x faster initialization when loading the Xilinx Blockset in the Simulink Library 
Browser

M-Based HW Co-Simulation

System Generator models compiled for HW Co-Simulation can now be embedded, 
configured and utilized in a MATLAB M-code script; allowing for calls into hardware to be 
made from MATLAB.
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Xilinx DSP Blockset Enhancements

FFT 5.0

Update to existing block which now includes cyclic prefix insertion

FIR Compiler 3.2

Update which now include support for Virtex II and Spartan 3A.

Reset Generator

New block that produces synchronized downsampled reset signals which eliminates the 
need to manually create these signals.

CIC Compiler 1.1

New block now available in System Generator.

Tool Flow and Integration
System Generator 10.1 is compatible with the following tools:

Tool Version

The Mathworks MATLAB® and Simulink 2007a and 2007b

Mentor Graphics ModelSim® SE 6.3c

Synplicity Synplify Pro® 8.8.0.4 (Requires a floating license for 
Hardware Co-Simulation)

Xilinx® AccelDSP 10.1

Xilinx® ChipScope Pro 10.1

Xilinx® EDK 10.1

Xilinx® ISE 10.1

Xilinx® ISE IP Update 10.1 IP Update 1

Xilinx® ISE Simulator 10.1
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Release Notes 9.2.01

System Generator Enhancements

EDK 9.2 SP1, PLBv46 & MB 7.0 Support

This release of System Generator supports Embedded Design Kit (EDK) Release 9.2SP1 
and the MicroBlaze PLB v4.6 bus interface. As shown in the figure below, when you export 
a System Generator design as a MicroBlaze processor core (pcore) using the EDK Processor 
block, you can choose to connect the pcore to the MicroBlaze v4.6 bus or the previously 
supported FSL (Fast Simplex Link). The PLB v4.6 is now the default choice.

When you select the PLB v4.6 option, the target MicroBlaze processor must have a PLB 
v4.6 bus properly connected to the DPLB interface and a proc_sys_reset module connected 
to the system reset pin. Also, both the pcore PLB memory map and the PLB bus should run 
at the same operating frequency. These requirements will be in place if you use the XPS 
Base System Builder to build the MicroBlaze processor.

Specifying a PLB v4.6 Base Address When you select the PLB v4.6 (Processor Local Bus) 
option, the bus address space will be automatically adjusted and minimized. If you know 
where you want the bus address space to start, you enter the address and click Lock. 
Otherwise, the base address will be automatically determined for you. This Base Address 
option is not used with the FSL Bus Type.

Note: Software simulation is disabled in this release. You can simulate the processor 
subsystem within System Generator and Simulink by connecting a supported hardware 
platform to your host computer and using Hardware Co-Simulation. See the topic Using 
Hardware Co-Simulation for details.

Pcore Export Enhancements

The EDK Export Tool has been enhanced to provide the following new features:

Asynchronous Software Drivers for FSLs

FSL-based pcores connect to the MicroBlaze processor using FIFOs. It is possible for users 
in XPS, to connect one clock to the processor and another to the System Generator pcore. In 
the past, if you did this there was a chance that data would be lost. 

In the release, you can set your software drivers to work in polling mode. Polling drivers 
will keep retrying (for a programmable number of times) to read or write data. Polling 
drivers are less efficient, but they are tolerant to clock differences between the Processor 
and Pcore.

To configure the software driver in Xilinx Platform Studio (XPS), you select the menu 
Software > Software Platform Settings to get the following dialog box shown below. You 
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click on Drivers and if Sysgen-based FSL pcores are available, driver parameters will be 
present as shown below. Select SG_POLLING to be true to enable polling drivers.

Export as Pcore Under Development

This feature works for both FSL- and PLB-based pcore export. When a pcore is marked as 
Pcore under development, XPS will not cache the HDL produced for this pcore. This is 
useful when you are developing pcores in System Generator and testing them out in XPS. 
You can just enable this checkbox, make changes in System Generator and compile in XPS. 
XPS always compiles the generated pcore, so you don’t have to empty the XPS cache which 
may contain caches of other peripherals, thus slowing down the compile of the final 
bitstream.

Enable Custom Bus Interfaces

This feature works for both FSL- and PLB-based pcore export and allows you to create 
custom bus interfaces that will be understood in XPS.
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Improved EDK Processor Bitstream Support

When you perform bitstream compilation on a System Generator design with an EDK 
Processor block, the imported EDK project and the shared memories sitting between the 
System Generator design and MicroBlaze processor are netlisted along with the System 
Generator design and included in the resulting bitstream. 

System Generator also attempts to compile any active software programs inside the 
imported EDK project. If the compilation of active software programs succeeds, System 
Generator invokes the data2bram utility to include the compiled software programs into 
the resulting bitstream. 

Note: No error or warning message is issued when System Generator encounters failures during 
software program compilation or when System Generator updates the resulting bitstream with the 
compiled software programs.

Once the bitstream is generated, you can modify the software programs in the imported 
EDK project and use the following command to compile the software programs, and 
update the System Generator bitstream without re-running Place & Route: 

xlProcBlockCallbacks('updatebitstream', [], xmp_file, bit_file, bmm_file);

where

• xmp_file is the pathname to the imported EDK project file

• bit_file is the pathname to the Sysgen bitstream file

• bmm_file is the pathname of the back-annotated BMM file produced by Sysgen 
during bitstream compilation

If the imported EDK project contains a BMM file named imported_edk_project.bmm, 
System Generator creates a back-annotated BMM file named 
imported_edk_project_bd.bmm. You should provide the later back-annotated BMM 
file to the above command in order to update the bitstream properly.

Spartan-3A DSP 1800A Starter Platform Support

System Generator now supports the Spartan-3A DSP 1800A Starter Platform for Ethernet 
Point-to-Point Hardware Co-Simulation.

Spartan-3A DSP 3400A Development Platform Support

System Generator now supports the Spartan-3A DSP 3400A Development Platform for 
Hardware Co-Simulation. Both the Point-to-point Ethernet configuration as well as the 
Network-Based Ethernet configuration are supported.

Simulation Speed Improvements

Simulation speed for designs created with the Xilinx DSP Blockset has been improved 
substantially in System Generator 9.2.01. This speedup is relative to the number of blocks 
in the design with large designs over 2000 blocks showing a 5x to 10x run time 
improvement. The following Simulink solver settings must be used to achieve the 
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maximum simulation performance improvement. These solver settings can be 
automatically configured by typing the “xlConfigureSolver” command at the MATLAB 
console.

RTL Improvements

In this release, if two or more Simulink Sub-systems are exactly the same, including input 
data types and mask parameters, only a single VHDL entity or Verilog module will be 
generated, then instantiated multiple times in the HDL code generated by System 
Generator. This optimization improves HDL logic synthesis runtime while reducing the 
amount of memory consumed by XST.

New JTAG Cable Sharing Option

A new option called Shared cable for concurrent access has been added to the properties 
dialog box for the JTAG Co-Simulation block. This option allows the JTAG cable to be 
shared with EDK XMD during a JTAG co-simulation. 

When the option is checked, the JTAG co-simulation engine only acquires a lock on the 
cable access and then immediately releases the lock when the access completes. Otherwise, 
the JTAG co-simulation engine holds the lock throughout the simulation. Due to the 
significant overhead on locking and unlocking the cable, this cable sharing option is 
disabled by default and only enabled when you check the box.
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Xilinx DSP Blockset Enhancements

Convolutional Encoder v6.1

• Support has been added for Spartan-3A DSP

Reed-Solomon Decoder v6.1

• Support has been added for Spartan-3A DSP

• The Field Polynomial entry in the GUI is now entered as a decimal number rather 
than a binary string.

Reed-Solomon Encoder v6.1

• Support has been added for Spartan-3A DSP

• The Field Polynomial entry in the GUI is now entered as a decimal number rather 
than a binary string.

Viterbi Decoder v6.1

• Support has been added for Spartan-3A DSP

Tool Flow and Integration
System Generator 9.2.01 is compatible with the following tools:

Known Issues
Known issues with this release can be found on the Xilinx web site at the following 
address:

http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=29595

Tool Version

The Mathworks MATLAB® and Simulink 2006b and 2007a

Mentor Graphics ModelSim® SE 6.1f

Synplicity Synplify Pro® 8.8.0.4 (Requires a floating license for 
Hardware Co-Simulation)

Xilinx® AccelDSP 9.2.01

Xilinx® ChipScope Pro 9.2.03i

Xilinx® EDK EDK 9.2 SP1

Xilinx® ISE 9.2.03i

Xilinx® ISE IP Update 9.2i IP Update 1

Xilinx® ISE Simulator 9.2.03i
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Release Notes 9.2.00

System Generator Enhancements

Single DSP Tools Installer using Xilinx Unified Installer

All Xilinx DSP Tools now use a Unified Installer for software installation and 
configuration.

System Generator MATLAB Selector

As part of the unified installation process, this configuration feature allows the user 
additional flexibility to specify which version of MATLAB/Simulink should be associated 
with a particular version of System Generator. This is helpful for users who have more 
than one version of MATLAB/Simulink or System Generator on their machine.

Selectable Block Frequency for Hardware Co-Simulation

If you are using a Xilinx ML402 or ML506 platform, at netlist time System Generator allows 
you to choose a clock frequency for the target design that is equal to or less than the system 
clock frequency. The following table outlines the frequencies that are available:

Platform Interface
System Clock 

Frequency
Available 

Frequencies 

Xilinx ML402 JTAG,
Point-to-point Ethernet,
Network-based Ethernet

100 MHz 100 MHz

66.7 MHz 

50 MHz

33.3 MHz

Xilinx ML506 Point-to-point Ethernet,
Network-based Ethernet

200 MHz 100 MHz

66.7 MHz

50 MHz

33.3 MHz 
30 www.xilinx.com System Generator for DSP
Release 10.1     March, 2008

http://www.xilinx.com


Release Notes 9.2.00
R

As shown below, you set the target clock frequency at compilation time by clicking the 
Settings button on the System Generator block dialog box, then select the frequency in the 
pulldown menu.

Clock Enable Fanout Reduction

A new mapping algorithm has been implemented that uses register duplication and 
placement based on recursive partitioning of loads on high fanout nets. This means 
improved FMAX on System Generator designs with large CE fanout. 

Although this feature is enabled in System Generator by default, the fanout reduction 
occurs downstream during the ISE mapping operation and the following MAP options 
must be turned on:

• Perform Timing-Driven Packing and Placement: on

• Map Effort Level: High

• Register Duplication: on

If you are using the ISE Project Navigator flow, these MAP options are also on by default. 
However, if you are using the default System Generator netlisting flow, you must turn 
these MAP options on by modifying the bitstream .opt file or by providing your own .opt 
file.

Shared Memory Stitching

Starting with this release, if two Shared Memory blocks with the same name exist 
anywhere in the design hierarchy, then during netlisting, the two blocks will be stitched 
into a single Shared Memory block. If a single Shared Memory block exists, then the input 
and output ports of the block are pushed to the top-level of the design.

If more than two Shared Memory blocks with the same name exist, then an error occurs.

This new stitching feature also applies to To FIFO and From FIFO block pairs with the 
same name and To Register and From Register block pairs with the same name.

2. Select

1. Click
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For backward compatibility, you can set the MATLAB global variable 
xlSgSharedMemoryStitch to “off” to bring System Generator back to the netlisting 
behavior before the 9.2 release. For example, from the MATLAB command line, enter the 
following:

global xlSgSharedMemoryStitch;
xlSgSharedMemoryStitch = 'off';

System Generator Requires a Simulink Variable-step Solver

Simulink divides simulation solvers into two types: fixed-step and variable-step. Both 
types of solvers compute the next simulation time as the sum of the current simulation 
time and a quantity known as the step size. With a fixed-step solver, the step size remains 
constant throughout the simulation. By contrast, with a variable-step solver, the step size 
can vary from step to step, depending on the model's dynamics. In particular, a variable-
step solver reduces the step size when a model's states are changing rapidly to maintain 
accuracy and increases the step size when the system's states are changing slowly in order 
to avoid taking unnecessary steps.

System Generator requires that you use a Variable-step solver for every Simulink 
simulation. The use of a Fixed-step solver is not supported and will be explicitly 
disallowed in a future release. Using a Fixed-step solver might result in an inaccurate 
System Generator simulation.

As shown below, to choose a Variable-step solver, select Simulation > Configuration 
Parameters... from the Simulink pulldown menu, then choose Variable-step from the 
Solver options.

1. Select

2. Select

3. Observe
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Xilinx DSP Blockset Enhancements

DDS Compiler v2_0

• Supports LogiCORE DDS Compiler 2.0

• Support has been added for Spartan-3A DSP

• New controls have been introduced to expose the rfd and rdy output ports. This 
feature has also been added to DDS Compiler v1.1

• channel input port has been renamed channelsel to avoid confusion with the channel 
output port

• Core initialization times have been significantly reduced both for DDS Compiler v1.1 
and DDS Compiler v2.0

FIR Compiler v3_1

• Supports LogiCORE FIR Compiler 3.1

• Faster simulation speeds when using re-loadable coefficients

• Support for Rounding in the FIR Compiler core through the following new 
parameters on the Advanced Pane of the Parameters dialog box:

♦ Rounding mode: List box with the following options:

- Full_Precision

- Truncated_LSBS

- Non_Symmetric_Rounding_Down

- Non_Symmetric_Rounding_Up

- Convergent_Rounding_To_Even

- Convergent_Rounding_To_Odd

- Symmetric_Rounding_To_Zero

- Symmetric_Rounding_To_One

- Symmetric_Rounding_To_Infinity

♦ Output Width: An editbox specifying the output width which is activated only if 
the Rounding mode is set to a value other than Full_Precision

♦ Allow Rounding Approximation: Check box that specifies if approximations can 
be allowed to save resources when using symmetric rounding

Help System Improvements

The System Generator Help System has gone through a major upgrade that includes a new 
HTML browser, a new comprehensive index and full text search capability.
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Tool Flow and Integration
System Generator 9.2.00 is compatible with the following tools:

Known Issues
Known issues with this release can be found on the Xilinx web site at the following 
address:

http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=29110

Tool Version

The Mathworks MATLAB® and Simulink 2006b and 2007a

Mentor Graphics ModelSim® SE 6.1f

Synplicity Synplify Pro® 8.8.0.4 (Requires a floating license for 
Hardware Co-Simulation)

Xilinx® AccelDSP 9.2.00

Xilinx® ChipScope Pro 9.2.02i

Xilinx® EDK EDK support is not available in this release 
of System Generator, and is expected to 
return in the next service pack.

Xilinx® ISE 9.2.02i

Xilinx® ISE IP Update 9.2i IP Update 1

Xilinx® ISE Simulator 9.2.02i
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Release Notes 9.1.01

System Generator Enhancements

New Technologies Supported

Spartan™-3A DSP. The new Spartan™-3A DSP series targets cost-sensitive, high-
performance signal processing applications.

Xilinx DSP Blockset Enhancements

FIR Compiler v3_0

• Supports LogiCORE FIR Compiler 3.0

• Support has been added for Spartan-3A DSP

• Supports interpolated filter implementations

• Maximum number of channels increased to 64

• Maximum integer rate change increased to 64

• Now exploits symmetry when interpolating by an even rate with an odd number of 
coefficients, reducing resource utilization

DDS Compiler v1_1

• Supports LogiCORE DDS Compiler 1.1

• Support added for Virtex™-5 and Spartan™-3A

DSP48 Macro

• Support added for DSP48A slice.

• The DSP48 Macro block provides a device independent abstraction for the DSP48, 
DSP48E and DSP48A slices.

DSP48A

• Supports DSP48A slice

• The DSP48A slice is unique to the Spartan™-3A DSP family of FPGAs. The DSP48A 
slices support many independent functions, including multiplier, multiplier 
accumulator (MACC), preadder/subtracter followed by a multiply-accumulator, 
multiplier followed by an adder, wide bus multiplexers, magnitude comparator, or 
wide counter.
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Tool Flow and Integration
System Generator is compatible with the following tools:

Migrating Designs Created in Previous Versions of Software
You must update v7.1, or earlier models to 9.1.01. Conversion instructions are provided in 
the next section that explain the process in detail. To update a model, you run a MATLAB 
command xlUpdateModel that invokes a conversion script. 

Please be advised that the conversion script does not automatically save an old version of your model 
as it updates the design nor save a new version of your model after conversion. You can either make 
a back up copy of your model before running the conversion script, or you can save the updated 
model with a new name. 

Some models may require some manual modification after running the conversion script. 
The script will point out any necessary manual changes.

Tool Version

The Mathworks MATLAB® and Simulink 2006a, 2006b

Mentor Graphics ModelSim® SE 6.1f

Synplicity Synplify Pro® 8.6.2 (Requires a floating license for 
Hardware Co-Simulation)

Xilinx® AccelDSP 9.1.01

Xilinx® ChipScope Pro 9.1.03i

Xilinx® EDK 9.1.01i

Xilinx® ISE 9.1.03i

Xilinx® ISE IP Update 9.1i IP Update 2

Xilinx® ISE Simulator 9.1.03i
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Upgrading a Xilinx System Generator Model

Upgrading v2.x and Prior Models
If you are upgrading from versions of System Generator earlier than v3.1, you must obtain 
System Generator v7.x and update your models to v7.x before you can update them to 
v9.1.01.

Upgrading v3.x, v6.x and v7.x Models
This section describes the process of upgrading a Xilinx System Generator v3.x, v6.x or 
v7.x model to work with v9.1.01. 

Note: Any reference to v3.x or v6.x in this section can be used interchangeably with v7.x. 

The basic steps for upgrading a v7.x model to v9.1.01 is as follows: 1) Save a backup copy 
of your v7.1 model and user-defined libraries that your model uses 2) Run 
xlUpdateModel on any libraries first and then on your model 3) Read the report 
produced by xlUpdateModel and follow the instructions 4) Check that your model runs 
under v9.1.01.

These steps are described in greater detail below.

1. Save a backup copy of your v7.1 model and user-defined libraries that your model 
uses.

2. Run the xlUpdateModel Function

From the MATLAB console, cd into the directory containing your model. If the name 
of your model is designName.mdl, type xlUpdateModel('designName').

The xlUpdateModel function performs the following tasks:

♦ Updates each block in your v7.x design to a corresponding v9.1.01 block with 
equivalent settings.

♦ Writes a report explaining all of the changes that were made. This report 
enumerates changes you may need to make by hand to complete the update.

In most cases, xlUpdateModel produces an equivalent v9.1.01 model. However, 
there are a few constructs that may require you to edit your model. It is important that 
you read the report and follow the remaining steps in this section.

3. Read the xlUpdateModel report and Follow the Instructions

If the report contains the issues listed below, manual intervention will be required to 
complete the conversion.

a. Xilinx System Generator v7.x models containing removed blocks

The following blocks have been removed from System Generator: CIC, Clear 
Quantization Error, Digital Up Converter, J.83 Modulator, Quantization Error, 
Sync.

b. Xilinx System Generator v7.x Models that Contain Deprecated Blocks

The DDSv4.0 block still exist in System Generator, but has been deprecated:

c. Xilinx System Generator v7.x Models Utilizing Explicit Sample Periods

The explicit sample period fields have been removed from most non-source blocks 
in System Generator v9.1.01. Source blocks (e.g., Counter block) continue to allow 
the specification of explicit sample periods. When upgrading models containing 
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feedback loops, Assert blocks must typically be added by hand after 
xlUpdateModel has been run. This is necessary in order to help System Generator 
determine appropriate rates and types for the path. The following error message is 
an indication that an Assert block is required:

“The data rates could not be established for the feedback paths through this block. 
You may need to add Assert blocks to instruct the system”

In such a case, you should augment each feedback loop with an Assert block, and 
specify rates and types explicitly on this block.

The update script will annotate the converted model wherever the v7.1 model 
asserted an explicit period. In the converted model, you will most often not need 
to insert Assert blocks. To find out where you need them, try to update the 
diagram (the Update Diagram control is under the Edit menu). If rates do not 
resolve, you will need to insert one or more Assert blocks. 

The update script can be configured to automatically insert Assert blocks 
immediately following blocks configured with an explicit sample period setting. 
To use this option, run the following command:

xlUpdateModel(designName,'assert')

4. Save and Close the updated model. 

If you did not previously make a backup copy of the old model, you can save the 
updated model under a new name to preserve the old model.

5. Verify that Your model Runs Under System Generator v9.1.01.

If you have followed the instructions in the previous steps, your model should run 
with System Generator v9.1.01. Open the model with System Generator v9.1.01 
and run it.

Examples
Example 1: 

>> xlUpdateModel('my_model_name'); 

Update the file my_model_name.mdl that is located in the current MATLAB working 
directory.

Example 2: 

>> xlUpdateModel('my_model_name','lib'); 

Update the file my_model_name.mdl that is located in the current MATLAB working 
directory, along with the libraries that are associated with the model.

Example 3: 

>> xlUpdateModel('my_model_name','assert’); 

Update the file my_model_name.mdl that is located in the current MATLAB working 
directory. Add Assert blocks where necessary.
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Chapter 4

Getting Started

Introduction
This Getting Started training consists of six short lessons that introduce you to major 
features of System Generator for DSP. Each lesson takes less than 10 minutes to read and is 
followed by one or more hands-on lab exercises. The lab exercise folders are located in the 
System Generator software tree and contain data files and step-by-step instructions. 

If you have System Generator installed on your computer, you can complete each lab 
exercise at your own pace and on your own time schedule. If you do not have System 
Generator installed, you can access this free training in a recorded e-learning format 
through the Xilinx web site at the following location: 
http://www.xilinx.com/support/training/rel/system-generator.htm

The lessons contained in this Getting Started are as follows:

• Lesson 1 - Design Creation Basics: Introduces the basics of creating and 
implementing a DSP design using System Generator. 

• Lesson 2 - Fixed Point and Bit Operations: Covers the use of the System Generator 
routing blocks for extracting and manipulating the individual bits of a fixed-point 
signal. 

• Lesson 3 - System Control: Covers the preferred methods for using System Generator 
to create finite state machines, logical control conditions, and the handling of bursty 
data typical of FFT and filtering operations. 

• Lesson 4 - Multi-Rate Systems: Shows the proper way to create multi-rate systems 
using upsampling and downsampling of data. 

• Lesson 5 - Using Memories: Covers proper usage of the Xilinx block RAM resources 
and the DSP blocks available for building DSP designs targeting Xilinx RAMs. 

• Lesson 6 - Designing Filters: Discusses methods for creating efficient FIR filters in the 
Xilinx devices, use of the FIR Compiler block for filter implementation, and use of the 
FDATool for filter design. 
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Lesson 1 - Design Creation Basics

The System Generator Design Flow
System Generator works within the Simulink model-based design methodology. Often an executable spec is 
created using the standard Simulink block sets. This spec can be designed using floating-point numerical precision 
and without hardware detail. Once the functionality and basic dataflow issues have been defined, System 
Generator can be used to specify the hardware implementation details for the Xilinx devices. System Generator 
uses the Xilinx DSP blockset for Simulink and will automatically invoke Xilinx Core Generator to generate highly-
optimized netlists for the DSP building blocks. System Generator can execute all the downstream implementation 
tools to product a bitstream for programming the FPGA. An optional testbench can be created using test vectors 
extracted from the Simulink environment for use with ModelSim or the Xilinx ISE Simulator.
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The Xilinx DSP Blockset
The Xilinx DSP blockset is accessed via the Simulink Library browser which can be launched from the standard 
MATLAB toolbar. The blocks are separated into sub-categories for easier searching. One sub-category, “Index” 
includes all the block and is often the quickest way to access a block you are already familiar with. Over 90 DSP 
building blocks are available for constructing you DSP system.
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Defining the FPGA Boundary
System Generator works with standard Simulink models. Two blocks called “Gateway In” and “Gateway Out” 
define the boundary of the FPGA from the Simulink simulation model. The Gateway In block converts the floating 
point input to a fixed-point number. You double-click on the block to bring up the properties editor which is where 
the fixed-point number can be fully specified.
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Adding the System Generator Token
Every System Generator diagram requires that at least one System Generator token be placed on the diagram. This 
block is not connected to anything but serves to drive the FPGA implementation process. The property editor for 
this block allows specification of the target netlist, device, performance targets and system period. System 
Generator will issue an error if this block is absent.
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Creating the DSP Design
Once the FPGA boundaries have been established using the Gateway blocks, the DSP design can be constructed 
using blocks from the Xilinx DSP blockset. Standard Simulink blocks are not supported for use within the Gateway 
In / Gateway out blocks. You will find a rich set of filters, FFTs, FEC cores, memories, arithmetic, logical and 
bitwise blocks available for use in constructing DSP designs. Each of these blocks are cycle and bit accurate.
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Generating the HDL Code
Once the design is completed, the hardware implementation files can be generated using the Generate button 
available on the System Generator token properties editor. One option is to select HDL Netlist which allows the 
FPGA implementation steps of RTL synthesis and place and route to be performed interactively using tool specific 
user interfaces. Alternatively, you can select Bitstream as the Compilation target and System Generator will 
automatically perform all implementation steps. 

If the Create Testbench option is selected, then System Generator will save and write test vector files that are 
extracted from the Simulink simulation and generate an HDL testbench and script files for ModelSim. This is an 
optional step that simply verifies that the generated hardware is functionally equivalent to the Simulink simulation. 
The script files must be used with ModelSim interactively.
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Model-Based Design using System Generator
Model-based design refers the design practice of creating a high-level executable specification using the standard 
Simulink blocksets or MATLAB first to define the desired functional behavior with minimal hardware detail. This 
executable spec is then used as a reference model while the hardware representation is specified using the Xilinx 
DSP blockset.
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Creating Input Vectors using MATLAB
Simulink is built on top of MATLAB allowing the use of the full MATLAB language for input signal generation and 
output analysis. You can use the “From Workspace” and “To Workspace” blocks from the Simulink Source and 
Sink libraries. Input values must be specified as an n rows x 2 column matrix where the first column is the 
simulation time and the second column includes the input values. This is a very popular way to generate input 
vectors for System Generator designs.
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Lesson 1 Summary
• You partition the FPGA design from the Simulink “system” using Gateway In / 

Gateway Out blocks.

• You always include a System Generator token on each sheet

• You should only use blocks from the Xilinx DSP blockset between the gateway blocks

• You should consider using the From / To workspace blocks to use MATLAB for input 
generation and output analysis

Lab Exercise: Using Simulink
In this lab, you will learn the basics of Simulink. You will use a Simulink blockset to 
generate a simple design and take it through simulation. You will then change the 
sampling settings to see its effect on the output. You will then learn how to create a 
subsystem.

The lab instructions are located in the System Generator software tree at the following 
pathname:

...<sysgen_tree>/examples/getting_started_training/lab1/lab1.pdf

Lab Exercise: Getting Started with System Generator
This lab introduces you to the basic concepts of creating a design using System Generator 
within the model-based design flow provided through Simulink. The design is a simple 
multiply-add circuit.

The lab instructions and lab design are located in the System Generator software tree at the 
following pathname:

...<sysgen_tree>/examples/getting_started_training/lab2/

Lab Instructions

Lab Design
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Lesson 2 - Fixed Point and Bit Operations

Fixed-Point Numeric Precision
System Generator supports three data types, Unsigned for positive only DSP operations, Signed which is two’s 
complement used for DSP operations that involve negative numbers and Boolean for 1-bit control signals. Each 
block will typically have quantization parameters. The initial quantization is defined by the Gateway In blocks.
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System Generator Fixed-Point Quantization
Xilinx fixed-point data types are defined by specifying the total number of bits then specifying the location of the 
binary point. The difference, which represents the number of bits to the left of the binary point, are the integer bits 
for ufixed numbers and the integer bits plus sign bit for signed numbers. Xilinx FPGAs do not require that fixed-
point numbers fall in pre-defined 8 bit boundaries as is the case with DSP processors. The logic can grow bit-by-bit 
to accommodate the required fixed-point precision. 
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Overflow and Round Modes
System Generator supports the overflow modes Wrap, Saturate and Flag as error. Wrap is the default because it 
has the least cost in hardware. Saturate requires System Generator to insert logic to perform that operation and 
therefore should only be used when necessary for the application

System Generator supports Truncate and Round of the LSB during the quantization process. Similar to the Wrap 
mode for overflow mode, Truncate has minimal hardware cost and is the default. Specifying the Round mode 
requires System Generator to insert extra logic and should be used when only necessary for the application.
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Bit-Level Operations
In a real DSP hardware system, not all operations can be expressed mathematically. Often a signal must be accessed 
by its individual bits. System Generator supports a set of bit-level operations that allow the reinterpret, combining, 
conversion and extraction of the individual bits of a signal. This can be used to pad, unpad and slice off the bits of 
a signal with a high degree of control. These blocks do not use any hardware resources
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The Reinterpret Block
The Reinterpret block forces the bits of a signal to a new type without regard for the numerical value or location of 
the decimal point. This block does not change the number of bits of a signal but simply reinterprets the data type.   
For example if the number 4 is represented as an unsigned [4 1] it is 1000. If this number is reinterpreted to be 
unsigned [4 0], the 1000 is now 8.
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The Convert Block
The Convert block changes the quantization of a number but not the value. This block can alter the number of bits 
used to represent a number. It can be used to convert a signed type to an unsigned type and visa versa. Often the 
Convert block is used to truncate the output fractional bits after a multiplication operation.
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The Concat Block
The Concat block concatenates two inputs into a single output at the bit level. This block has two input ports that 
are labeled hi and lo. The hi port occupies the MSB’s and the lo input occupies the LSB’s of the output signal. 
This block is useful for zero padding the MSBs or LSBs of a signal.
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Slice Block
The Slice block is used to access individual bits of a quantized number. This block provides several mechanisms by 
which the sequence of bits can be specified. If the input type is known at the time of parameterization, the various 
mechanisms do not offer any gain in functionality. If, however, a Slice block is used in a design where the input data 
width or binary point position are subject to change, the variety of mechanisms becomes useful. For example, the 
block can be configured to always extract only the top bit of the input, or only the integer bits, or only the first three 
fractional bits. 
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The BitBasher Block
The BitBasher block provides a textual method, based on Verilog syntax, for working with the signals at the bit 
level. This block supports concatenation and slicing if the input signal to create an output. It also allows for 
augmentation with constants. The BitBasher block supports up to 4 outputs that are inferred by the expressions
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Lesson 2 Summary
• Quantization and overflow options are available when the output of a block is user 

defined

• Quantization occurs when the number of fractional bits is insufficient to represent the 
fractional portion of a value

• Overflow occurs when a value lies outside the representable range

• Bit picking blocks allow combining of multiple buses into a single bus, force a 
conversion of data type without changing the number of bits, extract bits, and convert 
the number into different format

• The BitBasher block allows bit manipulation and augmentation through textual 
specification based in Verilog

Lab Exercise: Signal Routing
In this lab you will design and verify padding and unpadding logic using the System 
Generator signal routing blocks

The lab instructions are located in the System Generator software tree at the following 
pathname:

...<sysgen_tree>/examples/getting_started_training/lab3/lab3.pdf
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Lesson 3 - System Control

Controlling a DSP System
When you develop a DSP system in hardware, some level of control is usually required. This may include state 
dependent behavior or simply performing operations such as filter coefficient updating. System-level control may 
also be needed for controlling bursty data such as non-streaming FFTs.
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The MCode Block
The MCode block supports the use of MATLAB for implementing state dependent and branch conditional control 
operations. This block is not suitable for MATLAB that describes an algorithmic operation such as a FIR filter or 
Matrix inverse. The Xilinx AccelDSP tool can be used in these cases. The MCode block provides a convenient and 
efficient method for implementing state machines and complex muxing conditions. This is the recommended way 
to implement a finite state machine in System Generator.
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The Xilinx “xl_state” Data Type
When implementing a state machine using the MCode block, a Xilinx-provided MATLAB function called “xl_state” 
must be used to initialize a persistent variable. This function has two arguments, the first is the initial condition, the 
second is the quantization of the assigned variable. For example, if your state machine has 6 states, you need a 
quantization of 4-bits unsigned.
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State Machine Example
The figure below shows a simple 2-state FSM. This can be easily extended to more states. Notice that a variable 
called “state” is declared to be persistent and is initialized to 2 bits, unsigned using the “xl_state” function. A 
switch-case statement is then used to decode the inputs, branch to the next state and assign the outputs. 
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The Expression Block
The Expression block performs a bitwise not, and, or & xor on two input signals. The inputs can have a word length 
greater than 1. In cases where the two inputs have different word lengths, the binary points are matched up and 
then an element-by-element boolean operation is performed. This block provides a useful way to implement logical 
control in a DSP system
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Reset and Enable Ports
Most System Generator blocks that include memory or storage provide options to expose the reset and clock enable 
ports. If un-selected, these ports are automatically connected to the final hardware's global reset and clock enable or 
DCM schemes. Exposing these ports on the System Generator block creates a condition where the block is reset or 
enabled when either the global signals or the local signals assert TRUE. You should use these ports if greater control 
over these functions is required in the DSP system.
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Bursty Data
Several of the more complex DSP blocks offered in the Xilinx DSP blockset result in “bursty” data. For example, the 
non-streaming FFT requires several clock cycles to process the input data prior to generating valid output data. In 
these cases, these blocks include data flow control ports that must be used in the DSP system. These ports provide 
basic push mode dataflow control. They consist of a vin port which indicates that valid data is available at the 
inputs and vout which indicates that valid data is available at the outputs. 
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Lesson 3 Summary
• Use the MCode block for state machines and branch conditional logic

• Use the Expression block to implement logical control at the bit level

• Storage elements have the ability to include optional reset and clock enable pins that 
can be connected in System Generator

• Blocks that operate on bursty data include data flow control pins called vin and vout

Lab Exercise: System Control
In this lab you will be creating a simple state machine using the MCode block to detect a 
sequence of binary values “1011”. The FSM needs to be able to detect multiple 
transmissions as well, i.e., “10111011”

The lab data and instructions are located in the System Generator software tree at the 
following pathname:

...<sysgen_tree>/examples/getting_started_training/lab4/

Lab Instructions

Lab Data
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Lesson 4 - Multi-Rate Systems

Creating Multi-Rate Systems
The following illustration shows a typical base-station receiver. The tower has multiple antennas to provide 
sectored coverage of the area. The diagram shows that this results in two receiver channels. In each of these 
channels, there is some form of complex mixing, resulting in real and imaginary channels.

Often DSP systems such as this will down sample the input signals prior to the digital filtering steps performed 
during equalization and demodulation. Doing so can simplify the filter design and hardware significantly. These 
systems are referred to as “multi-rate” systems
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Up and Down Sampling Blocks
System Generator includes Up Sample and Down Sample blocks that change the system sample rate. The Up 
Sample block adds additional samples to the signal to achieve the desired rate change. The value of these new 
samples is either zero or the value of the last actual sample depending on the block options. The Down Sample 
block simply discards samples until it achieves the desired rate change. For example, downsample by 3 means to 
discard 2 out of every 3 samples.
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Rate Changing Functional Blocks
In addition to the straightforward “Up Sample” and “Down Sample” blocks, System Generator also provides rate 
changing functional blocks; that is blocks that also perform a specific function. The Parallel to Serial block will up 
sample, the Serial to Parallel block will down sample, the FIR Compiler, if using a resource-shared multiplier will 
down sample and the TDM block will up sample. 
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Viewing Rate Changes in Simulink
Simulink supports viewing different sample times as different colors which is fully supported for System Generator 
blocks. To enable the Sample Time Colors feature, select the pulldown menu Format > Sample Time Colors. The 
Simulink tool does not automatically recolor the model with each change you make to it, so you must select Edit > 
Update Diagram to explicitly update the model coloration. To return to your original coloring, disable the sample 
time coloration by, again, choosing Sample Time Colors.
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Debugging Tools
System Generator provides 3 debugging utilities to assist in debugging complex multi-rate systems. 

The Sample Time (ST) probe can be connected to any System Generator signal then to a Simulink “display” block 
from the “Sinks” library. The sample time for the connected net will appear in the display. 

The clk probe is not connected to any inputs but only to a scope output. It displays the master clock. This can be 
used with the Clock Enable Probe to display the behavior of the clock enable signal at various points in the down 
sampling
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Sample Period “Rules”
The illustration below is an example of a multi-rate system that demonstrates how the Simulink System Period can 
be calculated and entered into the System Generator token GUI. 

If you get it wrong, there is a sampling period analyzer that automatically determines the appropriate sample 
period and prompts you to update the GUI.
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Lab Exercise: Multi-Rate Systems
In this lab you will be exploring the effects of the rate changing blocks available in System 
Generator. These blocks include Upsample, Downsample, Serial to Parallel and Parallel to 
Serial.

The lab instructions and lab design are located in the System Generator software tree at the 
following pathname:

...<sysgen_tree>/examples/getting_started_training/lab5/

Lab Instructions

Lab Design
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Lesson 5 - Using Memories

Block vs. Distributed RAM
Xilinx FPGAs offer two distinct memory options, Block RAM and Distributed RAM. Block RAM uses dedicated, 
on-chip, hardware resources and represents the most area-efficient RAM implementation. Block RAMs offer high 
performance but due to their fixed location on the chip, may incur slightly larger routing delays. Distributed RAM 
uses the lookup tables in the FPGA slices to implement memory and in doing so will subtract from the slices 
available for logical operations. Because Distributed RAM can be located anywhere throughout the chip, routing 
delays can be minimized and slightly higher performance can be achieved. Distributed RAM is an excellent option 
for small FIFOs.
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Initializing RAMs and ROMs
The RAM and ROM blocks can be initialized to a 1xn vector that matches the depth of the RAM. MATLAB is used 
to set the initial value vector. Any MATLAB statement can be used that results in a 1xn vector including the file 
reading commands such as imread, auread, wavread, and load.
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System Generator RAM Blocks
System Generator provides both a single- and dual-port RAM block. Depths up to 64K are supported. Both 
Distributed RAM and Block RAM implementation options are available. System Generator calls the Xilinx memory 
compiler to create an efficient memory structure in hardware for the given parameters, bit widths and depths. You 
don’t need to be concerned with the hardware details of the specific Virtex block or Distributed RAM structure. 
Both the single- and dual-port RAM blocks support initialization. The signal connected to the address port of a 
RAM must be unsigned with no fractional bits. 
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System Generator ROM Blocks
The ROM block supports an implementation in either Block- or Distributed RAM and is initialized through a 
MATLAB command. The signal connected to the address port must be unsigned with no fractional bits
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The Delay Block
The Delay block is used to synchronize dataflow through the FPGA. This block maps to a highly-efficient shift 
register structure built from a slice lookup table called an SRL16 that is 85% smaller than using registers.
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The FIFO Block
The FIFO block supports both Block RAM and Distributed RAM implementations. Depths up to 64K are supported. 
Three output flags are supported, empty, full and %full. The %full flag is set depending on a bit width 
specification. One bit will be zero until the FIFO is 50% full, then it will set to.5.  Two bits will be zero until 20% full, 
then .25, .5 and .75. 
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Lab Exercise: Using Memories
In this lab you will learn how to use a Xilinx ROM block to implement a LUT-based 
operation such as an Arcsin using Block RAM or Distributed RAM. This provides an 
efficient implementation for trig and math functions with inputs that can be quantized to 
10 bits or less.

The lab instructions and lab design are located in the System Generator software tree at the 
following pathname:

...<sysgen_tree>/examples/getting_started_training/lab6/

Lab Instructions

Lab Design
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Lesson 6 - Designing Filters

Introduction
Digital filters are a common DSP operation and especially well suited to implementation in FPGAs. High-
performance applications benefit greatly from parallel filters that can return a results on every clock cycle. The 
Virtex 5 device includes up to 550 parallel multipliers. The FIR Compiler is designed to use these multipliers in the 
most efficient manner for creating commonly used FIR filters. An alternative implementation is available called 
“distributed arithmetic” that creates FIR filters without using multipliers by employing a shift-add technique. This 
can be used for smaller devices when the available multipliers have been allocated to other functions.
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The Virtex DSP48 Math Slice
The Virtex™ family introduces a high-performance arithmetic unit along with a multiplier: the low-power DSP48 
slice. The following figure is a detailed diagram of the DSP48 structure. The DSP48 slice consists of four main 
sections: (1) I/O registers, (2) signed multiplier, (3) three-input adder/subtractor, and (4) OPMODE multiplexers.
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FIR Compiler Block
The Xilinx Fir Compiler v1_0 block implements a high speed MAC based FIR filter. It accepts a stream of input data 
and computes filtered output with a fixed delay, based on the filter configuration. The FIR Compiler supports 
generation of resource shared or parallel FIR structures and polyphase decimation and interpolation structures. 
Also supported is oversampling. Coefficients are specified using MATLAB commands. 
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Creating Coefficients with FDATool
The Mathworks FDATool is a graphical filter design program that can be used to generate coefficients for the FIR 
Compiler block. 
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Using FDA Tool Coefficients
Once a suitable filter response has been designed, you simply export the coefficients to the workspace using the
File > Export command. The workspace variable can then be referenced in the FIR Compiler properties editor
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Lab Exercise: Designing Filters
In this lab you will be using the Filter Compiler block to generate optimized filters for the 
Virtex4 architecture.

The lab instructions and lab design are located in the System Generator software tree at the 
following pathname:

...<sysgen_tree>/examples/getting_started_training/lab7/

Lab Instructions

Lab Design
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Additional Examples and Tutorials
Numerous examples are used to illustrate System Generator features and functions in the 
System Generator documentaton. These examples are found in the directory at pathname 
<sysgen_tree>/examples and are listed in the table below. In addition to these 
examples, System Generator also includes demonstration models that can be run from the 
demo page. Enter the following command at the MATLAB prompt: 

demo blocksets xilinx

Note: If you are using the MATLAB help browser you can open and run the examples directly from 
this page. To run an example, click on the link. MATLAB will change directories to the example 
directory and open the example model. 

Black Box Examples

ChipScope Examples

Topic Description

 Importing a VHDL 
Module

A tutorial showing how to use the black box to import VHDL into a 
System Generator design and how to use ModelSim to co-simulate 
the VHDL module. 

 Simulating Several 
Black Boxes 
Simultaneously

Shows how black boxes can co-simulate simultaneously, using only 
one ModelSim license. 

 Dynamic Black Boxes A tutorial showing how to parameterize the black box. 
 

 Importing a Verilog 
Module

A tutorial showing how to use the black box to import Verilog into 
a System Generator design and how to use ModelSim to co-simulate 
the Verilog module.  

 Importing a Xilinx 
Core Generator 
Module

A tutorial showing how to import a COREGEN module as a black 
box. 

Topic Description

 Using ChipScope Pro 
Analyzer for Real-
Time Hardware 
Debugging

This tutorial demonstrates how to connect and use the Xilinx Debug 
Tool called ChipScope Pro within Xilinx System Generator. The 
integration of ChipScope Pro in the System Generator flow allows 
real-time debugging at system speed. 
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DSP Examples

Topic Description

 DSP48 Block Simple example demonstrating the use of the DSP48 block with the 
Constant block used to provide the DSP48 instruction. 

 DSP48 Macro Block Simple example demonstrating how to use a DSP48 Macro block to 
implement a Complex Multiplier. 

 DSP48 Block

(35-Bit Multiplier 
using DSP48 and 
Constant block)

This design demonstrates the use of the DSP48 and Constant block 
in implementing 35 by 35-bit multipliers at different sample rates. 
Three multipliers implementations are shown at 1, 2, and 4 clocks 
per sample. 

 DSP48 Macro Block

(FIR filter using the 
DSP48 Macro block as 
a multiply accumulate 
function)

This design demonstrates the use of the DSP48 Macro block in 
implementing a 35 by 35 Multiplier. 

 DSP48 Block

FIR filter examples 
using DSP48 block

This design demonstrates the use of the DSP48 and Constant block 
in FIR filter implementation. The design includes sets of parallel, 
semi-parallel and sequential FIR filter using Type 1 and Type 2 
architectures. Each filter implements a 16-tap dsp48-based FIR 
filters. 

 DSP48 Design 
Techniques

(DSP48-based 
dynamic shifter)

This design demonstrates the use of the DSP48 block in 
implementing a 35-bit signed right shift using 2 DSP48s.

 DSP48 Design 
Techniques

(Synthesizable FIR 
filter for Virtex4)

This design demonstrates how to use System Generator to 
implement a synthesizable FIR filter which maps efficiently to the 
Virtex4 architecture. 

 DSP48 Macro Block

(FIR filter using the 
DSP48 Macro block as 
a multiply accumulate 
function)

This design demonstrates the use of the DSP48 Macro block when 
implementing a sequential FIR filter. 

MAC FIR filter This design example implements a 43 tap FIR Filter with a MAC 
engine and a Dual Port Ram used for data and coefficient storage. 

Complex FIR filter This example demonstrates a complex FIR filter built out of blocks 
from the System Generator and Simulink library. 
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M-Code Examples

Processor Examples

Topic Description

Simple Selector This example shows how to implement a function that returns the 
maximum value of its inputs. 

Simple Arithmetic 
Operations

This example shows how to implement simple arithmetic 
operations. 

Complex Multiplier 
with Latency

This example shows how to build a complex multiplier with latency. 

Shift Operations This example shows how to implement shift operations. 

Passing Parameters 
into the MCode Block

This example shows how to pass parameters into a MCode block.

Optional Input Ports This example shows how to implement optional input ports on an 
MCode block. 

Finite State Machines This example shows how to implement a finite state machine.

Parameterizable 
Accumulator

This example shows how to build a parameterizable accumulator. 

FIR Blocks and 
Verification

This example shows how to model FIR blocks and how to do system 
verification. 

RPN Calculator This example shows how to model a RPN calculator – a stack 
machine. 

Example of disp 
function

This example shows how to use the disp function. 

Topic Description

 Designing and 
Exporting MicroBlaze 
Processor Peripherals

Demonstrates how to export a design from System Generator into 
Xilinx Platform Studio (EDK) by showing how to design a 
peripheral (pcore) for a MicroBlaze processor. An RGB to gray-scale 
color space converter is created and generated into a pcore using the 
Export to EDK compilation target. 
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Shared Memory Examples

 Tutorial Example - 
Designing and 
Simulating 
MicroBlaze Processor 
Systems

Demonstrates how to import a MicroBlaze processor created using 
Xilinx Platform Studio into System Generator. A DSP48 block is 
used as a co-processor to the MicroBlaze. 

 Designing PicoBlaze 
Microcontroller 
Applications

Demonstrates how to implement a PicoBlaze program in System 
Generator. The example programs the PicoBlaze to alter the output 
frequency of a Direct Digital Synthesizer (DDS) during an interrupt. 

Topic Description

Topic Description

Simulation across 
various models

Illustrates shared memories communicating across Simulink 
models. 

Host PC Shared 
Memory access

Developer studio project to communicate with a shared memory.

High Speed Video 
Processing using 
Hardware Co-
simulation

Discussion of a high-speed co-simulation buffering interface 
followed by an example in which the interface is used to support 
real-time processing of a video stream using a 5x5 filter kernel. 

High speed I/O 
Buffering

Illustrates high speed Shared Memory I/O Buffering Interface for 
Hardware Co-simulation. 

 SharedMemory

(Mex-function 
interface)

Illustrates the use of a mex-function as an interface to a shared 
memory. 

 Generating Multiple 
Cycle-True Islands for 
Distinct Clocks

An example using two asynchronous clocks. 

Shared Memory, To 
FIFO, To Register, To 
Register, From 
Register

Demonstrates use of shared memories, FIFOs and registers to pass 
information. 

 Frame-Based 
Acceleration using 
Hardware Co-
Simulation

Explains how to use frame or vector-based transfers to further 
accelerate simulations using FPGA hardware co-simulation. 
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Timing Analysis Examples

Miscellaneous Examples

Topic Description

 Timing Analysis 
Tutorial

Explains how to use the System Generator Timing Analysis tool to 
meet timing requirements of System Generator designs. Also 
touches on techniques that may be used when a design does not 
meet timing. 

Topic Description

 Importing a System 
Generator Design into 
a Bigger System

Discusses how to take the VHDL netlist from a System Generator 
design and synthesize it in order to embed it into a larger design. 
Also shows how VHDL created by System Generator can be 
incorporated into simulation model of the overall system.

 Configurable 
Subsystems and 
System Generator

Illustrates the use of Configurable Subsystems for Simulation and 
Generation. 

Integrator This example uses an integrator to illustrate error analysis 
capability. 

Block RAM-Based 
State Machines

Demonstrates use of Mealy State Machine block from the reference 
library. 
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System Generator Demos
System Generator for DSP provides the capability to model and implement high-
performance DSP systems in field- programmable gate arrays (FPGAs) using Simulink. 
The Xilinx Blockset contains bit and cycle-true models of arithmetic and logic functions, 
memories, and DSP functions for digital filtering, spectral analysis, and digital 
communications. System Generator converts a Simulink model of Xilinx blocks into an 
efficient hardware implementation that combines synthesizable VHDL and intellectual 
property blocks that have been hand-crafted to run efficiently in FPGAs. 

Included with the tool are numerous demonstration designs that highlight key features 
and tool capabilities, as well as general good design practices using real-world design 
applications. These designs may be accessed from the System Generator demo page. Enter 
the following command at the MATLAB prompt: 

demo blocksets xilinx
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